
Preparing Course Materials 

Three ways to edit a WebCT HTML Document 
Method 1:  If you have the original web page that you copied from or 

uploaded you may edit this file with the program you used to create it and 
then re-upload the file. 

Method 2:  If you do not have the original file you may select the file, then 
edit in Manage Files and edit either with the text editor or the HTML editor. 
Note: If you edit with the text editor you will see the HTML tags.  

Method 3:  Download the file and then edit it in the program you used to 
create it.  

Method 1: Download File from WebCT using Manage Files 
1. Open your browser and login to your WebCT course. Click on the Control Panel and 

then Manage Files.  
Find the file you wish to download by looking through the folders and files panel. 
Once you have found the file, click the checkbox to the left of the file's name.  
Click the "Download" button in the Actions Panel. Click the download and specify a 

place to store the file. 
Click "Save".  
Open the file for editing in the program that originally created it. 

Method 2: Download a File using WebDAV 
2. Open the WebDAV folder that contains the web page or other file you wish to 

download. 
Drag the file to your desktop and wait for the copy process to finish. 
Make changes to the file and save it. 
Drag the file into the same location in the course WebDAV folder as the original file and 

the original file will be overwritten and the link to the content will not need to be 
changed. 

Open the File in the program that created it (word, FrontPage, PP, 
etc) 

3. Open the program. Go to "File" > "Open" and search through your computer or disk 
to find the file that you just downloaded from WebCT. (Please note that the file will 
probably be an HTML file. When you begin searching for the file, you need to see 
"File Type" listed as HTML.)  

Open the file and make any desired changes. When you have finished editing the file, 
remember to save it with the same name  

Replace the older version of the file in WebCT with the newer one that you just saved. If 
you save it to the same location as the old file, the old file will be replaced and the 
link will not break.  

Replace the Older File 
Now, switch back to your WebCT course. You should still be in the "File Manager". 
Click "Upload" on the Action Panel.  
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Upload the edited file to the same location as the original file. 
WebCT will tell you that the current file already exists in your course. Click "Overwrite" 

to replace the older file with the newer file that you just edited.  
Check the link to the file on your course pages to make sure it is still working.  

Method 3: 
Edit the file online using WebCT’s built on HTML/Web Page editor.  

Using the HTML Editor 
Note: Depending on administrator settings, this feature may not be available. 
The edit-on Pro editor by RealObjects is a What You See Is What You Get (WYSIWYG) 
Hypertext Markup Language (HTML) editor which allows you to create and publish 
content on the Web without having to know HTML. 
 
The HTML editor provides word-processor-like features that display text and graphics 
the same as they will appear in a browser. The HTML editor is available from Content 
Module, Discussions, Mail, Manage Files, Organizer Pages, Student Homepages, and 
Student Presentations. 
 
For more information about the RealObjects edit-on Pro HTML editor, from the 
HTML editor toolbar, click About. The About dialog box appears. 

About the different views in HTML editor 
The edit-on Pro HTML editor allows you to work on your content in two different 
ways—using WYSIWYG view, which displays text and graphics as they will appear in a 
browser, or using HTML View, which displays the HTML code. 
To change the view in which you're working, on the HTML editor status bar, click 
WYSIWYG or HTML View. 

Expanding or shrinking the toolbar 
If you want to expand or shrink the toolbar in the HTML editor, click Shrink the toolbar 

or expand the toolbar . The toolbar shrinks or expands. 

Showing all paragraph marks 
You can show or hide paragraph marks and other formatting marks. Showing paragraph 
marks helps you see where each paragraph ends. To show all paragraph marks, click 
Show All . The paragraph marks and other formatting marks show. 

Using the HTML editor on a Macintosh 
If you are working on a Macintosh, before you exit the HTML editor, make sure you save 
your changes by clicking Save . If you exit the HTML editor without saving, any 
changes you made in the HTML editor will disappear. 
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Entering Text 
You can enter text in the HTML editor the same way you enter text in a word processor. 
4. In the tool, click HTML editor. The HTML editor appears.  
In the editing area, enter your text.  

Formatting Text 

Changing the font of text 
Note: The default font type is Serif. 
5. Select the text you want to change.  
6. From the Font Type drop-down list , select a font type. The selected text 

is modified.  

Changing the size of text 
Note: The default font size is 12. 
7. Select the text you want to change.  
8. From the Font Size drop-down list , select a font size. The selected text is 

modified.  
 

Applying bold formatting to text 
9. Select the text you want to change.  
From the toolbar, click Bold. The selected text is bold.  
 

Applying italic formatting to text 
10. Select the text you want to change.  
From the toolbar, click Italic. The selected text is italic.  
 

Underlining text  
11. Select the text you want to change.  
From the toolbar, click Underline. The selected text is underlined.  
 

Changing the color of text 
12. Select the text you want to change.  
From the toolbar, click Font Color. The Colors dialog box appears.  
Under Standard Colors, click a color. Note: If you mouse over a color, the color's 

name and hexadecimal code appear in the dialog box's title bar. 
The color of the selected text changes.  
a. If you want to add a custom color:  

• In the RGB text box, enter a hexadecimal code.  
• Click Add to custom colors.  
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• Under Custom Colors, click the custom color. The color of the selected text 
changes.  

Formatting Paragraphs 

Applying a paragraph format 
13. Click the paragraph you want to change.  
14. From the Paragraph Format drop-down list , select a format. The 

selected paragraph is modified.  

Aligning text with the left margin 
15. Select the text you want to change.  
From the toolbar, click Align Left . The text is aligned to the left.  

Centering text 
16. Select the text you want to change.  
From the toolbar, click Center . The text is centered.  

Aligning text with the right margin 
17. Select the text you want to change. 
18. From the toolbar, Click Align  Right. The text is aligned to the right.  
19. Increasing the left indent of an entire paragraph 
Select the paragraph you want to change.  
From the toolbar, click Increase  Indent. The indent increases.  

Decreasing the left indent of an entire paragraph  
20. Select the paragraph you want to change.  
From the toolbar, click Decrease Indent . The indent decreases.  

Adding Bullets or Numbers to a List 
21. In the editing area, click where you want the list to appear, or select the item(s) you 

want to add bullets or numbers to.  
22. From the toolbar, do one of the following:  

a. To add bullets, click Bullets .  
b. To add a numbered list, click Numbered List .  
c. To add an alphabetical list, click Alphabetical List .  

Note: When you press Enter to add the next list item, the HTML editor 
automatically inserts the next bullet or number. When you want to finish the list, 
click Bullets , Numbered List , or Alphabetical List again. 

Moving or Copying Text and Images 
23. Select the item you want to move or copy.  
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24. Do one of the following:  
a. To move the item, from the toolbar, click  Cut.  
b. To copy the item, from the toolbar, click Copy.  

Click where you want the item to appear.  
From the toolbar, click Paste.  

 

Inserting Text from another Source 
You can insert text from another source into the editing area. 
25. Copy the text from the other source.  
26. In the editing area, click where you want the content to appear.  
27. From the toolbar, click Insert Text. The Paste Text from Clipboard dialog box 

appears.  
28. Paste the text into the dialog box by pressing CTRL+V.  
29. Do one of the following:  

a. If the text is in plain text format, select Plain Text.  
b. If the text is in HTML format, select HTML.  

Click OK. The text is inserted.  

Inserting a Symbol 
30. In the editing area, click where you want to insert a symbol.  
31. From the toolbar, click Insert  Symbol. The Insert Symbol dialog box appears.  
32. Click the symbol you want to insert. The symbol appears in the Insert box.  
33. Click Insert. The symbol is inserted.  
34. To close the Insert Symbol dialog box, click Close.  

Inserting an Image 
35. In the editing area, click where you want to insert an image.  
36. From the toolbar, click Insert Image. The Insert Image dialog box appears.  
37. In the Source text box, do one of the following:  

a. If the image is saved in the main My-Files folder, enter the file name of the 
image. For example, to insert an image named Europe_map.gif, which is saved in 
the main My-Files folder, you would enter Europe_map.gif.  

b. If the image is saved in a folder within My-Files, enter the path and file name of 
the image. For example, to insert an image named Asia_map.gif, which is saved 
in a folder named Maps in the main My-Files folder, you would enter 
Maps/Asia_map.gif.  

c. If the image is on a different web site, enter the full address of the web site, the 
path, and the file name of the image.  

In the ALT-String text box, enter a short description of the image. This text displays in a 
browser when you mouse over the image.  

In the Border Width text box, enter the width of the border in pixels.  
In the Size text boxes, enter the width and height of the image in pixels, and click OK. 

The image is inserted.  
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Inserting a Horizontal Line 
38. In the editing area, click where you want to insert a horizontal line.  
39. From the toolbar, click Insert Horizontal Line . A horizontal line is inserted.  

Inserting and Modifying a Table 

Inserting a table 
40. In the editing area, click where you want to insert a table.  
41. From the toolbar, click Insert  Table. The Table Properties dialog box appears.  
42. Select the desired number of rows and columns; the table, row, column, cell, and 

color properties, and click OK. The table is inserted.  

Inserting the default table 
The HTML editor's default table has four columns and three rows. 
43. In the editing area, click where you want to insert the default table.  
44. From the toolbar, click Insert Default   Table. The table is inserted.  

Adding a row to a table 
45. In the table, click in a cell above or below where you want to insert the row.  
46. From the toolbar, click Insert     Row. The Insert Row dialog box appears.  
47. Select the position in which you want to insert the row and click Insert Row. The row 

is inserted.  

Adding a column to a table 
48. In the table, click in a cell to the left or right of where you want to insert the column.  
49. From the toolbar, click Insert   Column. The Insert Column dialog box appears.  
50. Select the position in which you want to insert the column and click Insert Column. 

The column is inserted.  

Inserting a Hyperlink 
You can create a link from text or an image to another document or web site. 
51. Select the text or image you want to represent the hyperlink.  

52. From the toolbar, click Insert      Hyperlink. The Insert Hyperlink dialog box 
appears.  

53. In the HREF text box, do one of the following:  
a. If you want to insert a link to an HTML document saved in the main My-Files 

folder:  
• Delete http://.  
• Enter the file name of the document. For example, to insert a link to an 

HTML document named European_history.html, which is saved in the main 
My-Files folder, you would enter European_history.html.  

b. If you want to insert a link to an HTML document saved in a folder within the 
main My-Files folder:  
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• Delete http://.  
• Enter the path and file name of the document. For example, to insert a link 

to an HTML document named Asian_history.html, which is saved in a 
folder named History in the main My-Files folder, you would enter 
History/Asian_history.html.  

c. If you want to insert a link to a web site, enter the full address of the web site, 
including the protocol http:// or https://.  

To the right of the Target text box, click and select the location in which the link 
should appear.  

Click OK. The hyperlink is inserted.  

Inserting HTML 
You can insert an external HTML page. 
54. In the editing area, click where you want to insert the HTML file.  
55. From the toolbar, click Insert HTML .    The Insert HTML file at current position 

dialog box appears.  
56. In the URL text box, following http://, enter the full address of the web site, the path, 

and the file name of the page.  
57. Click OK. The page is inserted.  

Checking Spelling 

58. From the toolbar, click Spelling        Check. If the HTML editor finds a possible 
spelling error, the Check Spelling dialog box appears.  

59. Make your changes.  
60. When the spelling check is complete, click OK. 
 

Building Content Modules 

Preparing Course Materials for loading into WebCT;  

Converting Microsoft Word Documents to HTML 
Open the existing Word file.  
Delete unnecessary images.  
Choose file > Save as HTML (save as Web Page), or, better, if available, File > Export > 

Compact HTML. (This "export" function may be enabled if you have Word 2000); 
Navigate to the directory (folder) where you want to keep your Web Documents. 
Keep your converted Web Page in a directory separate from source documents, such 
as the original Word document that you are presently converting to HTML. See 
Figure 18.  
 
Note: If you are using Office XP, Choose File > Save As Web Page, change the 
“Save As Type” to “Web Page filtered”.   Check to make sure the document title 
accurately reflects the page content (it may become the link text when you link the 
file to WebCT tool), make sure the file name contains NO spaces. The only dot 

   7



should be directly before the file extension. Note: Your page may look quite different 
in the browser from how it appears in Word. In particular, check for: 
Paragraph returns - these cause double line spaces where you expect single? **  
Tabs - Tabs do not convert to HTML. Remove them from the Word document before you 

convert. You many align columns using tables. 
Close the browser window, return to Word and revise as necessary.  
Resave or export the document.  
Images are not embedded in HTML documents as they are in Word documents. Rather, 

images are stored as separate files that the HTML document links to. 
Word creates a new folder for the images included on each Web page. The folder is 

named after the file (filename files) and is stored in the same folder as the HTML file. 
Word creates numbered graphics files (.gif and .png) for each image. Whenever you 
move or copy the HTML file you must keep the HTML file and its file folder 
together. Also, do not change the file names or folder names, or visitors to your site 
will see a broken image icon instead of a picture. 

Show file extensions on desktop 
To set the Windows OS to show file extensions so that you can see the file types of your 
documents (.doc, .html, .gif, .png, etc.): 

Windows 98: Start > Settings > Folder  
Options: View tab; uncheck 'Hide file extensions for known file types.' 

Windows 2000: Start > Settings > Control Panels > Folder options. 

HTML filter for files produced in MS Word 2000 
 
MS Word 2000 has an option in File, Save As which allows you to convert Word 
documents to HTML format files without the Office-specific code which web browsers 
will not need. The free filter can be downloaded at 
http://office.microsoft.com/downloads/2000/Mshtml2.aspx.  
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Show Invisible Markers 
Turn on invisible markers to see paragraph 

returns, soft-returns, spaces and tabs that you 
may want to remove or reformat. 

Choose Tools >Options > View tab: 
Formatting Marks; check “All.” 

 
(Mac—Tools > Preferences > View tab: Non-

printing characters; check “All”. 
 

Alternately, depending on how the Tool bar in 
your copy of MS Word is set up, you may be 
able to see the Show Hide Markers button.  

Paragraphs versus Line 
Breaks 

In HTML, unlike in word 
processors such as MS Word, 

paragraph returns create a 
double line space. 

Pressing the ENTER key 
makes a “hard return” or 
Paragraph: TWO LINE 

SPACES SHIFT + ENTER 
makes a “soft return”, or line 
break: ONE LINE SPACE. 

        

Make your document conversion-friendly 
The Word to HTML converter (Save as Web Page) is not perfect. Before continuing, 
look through your document and correct elements that convert poorly. Three rules to 
live by in creating Word documents that convert well to HTML are listed below. 
61. When you want to line text or numbers up in columns always use tables (with borders 

turned off) NEVER use tabs or spaces. Columns aligned with tabs and spaces in 
Word will not be aligned when you convert to HTML. Some newer versions of Word 
will align these types of columns but in doing so will add a lot of extra code to your 
web page thus making your page load more slowly and possibly causing 
compatibility problems for some students. 

Allow text to wrap in paragraphs (keep typing and let the text to automatically go to the 
next line). Do not press the return key (hard return – new paragraph) or the shift and 
return keys (soft return or line break – new line same paragraph) at the end of each 
line. Text that wraps will display well on any sized screen. Pressing the return key at 
the end of each line will only display correctly on screens that are the same size as the 
screen you are using when you create the document.  

Use the numbered list or bulleted list buttons to create the corresponding list types. Do 
not type the numbers or bullets. Using the list button formatting will correctly format 
the text that appears in the lines below the first line in the list item. When students 
resize the screen the browser will adjust the line formatting correctly. Typing the 
number or bullet at the beginning of a list item will create formatting problems in 
screen sizes that are different than your screen size.  

Using FrontPage 2000 to Convert Word Documents to Web Pages:  
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Another way to convert Word documents to web pages is to use FrontPage as a 
conversion utility.  
Open FrontPage 2000. 
Insert the Microsoft Word file into FrontPage 

a. Click on Insert on the menu bar, click on File, change the Files of type setting to 
All, select the desired file type and then click on Open. The file will be 
converted to HTML format and inserted into the FrontPage page. 

b. Click on the Preview tab at the bottom of the screen to see how the file will look 
in a web browser. Switch back to the Normal tab and make any necessary or 
desired changes just as you would in a word processor 

c. Creating the Document Title for WebCT: When WebCT displays information 
about the HTML version of this document, the information will include a 
document title. This page title will automatically appear as the link text to the file 
in WebCT. You can control what this title says, by creating and/or changing it in 
FrontPage. To do so 
• Right-click anywhere in the document and select Page Properties. The 

Page Properties dialog box is displayed, as shown below. 
• Type the desired title into the Title text box and then click on OK. 

 
Saving the Converted File:  
Once the file has been converted you need to save it. If the new web page has images, 
you will want to save the file and the images in the same folder on your computer. When 
you upload the web pages and the images to WebCT you will also need to upload the 
converted file and folder of images to the same folder so that the links to the images do 
not break. 
62. Click on File in the menu bar, and then click on Save As. 
Type the desired name of the file in the File Name text box, select the desired location 

and then click on Save. If the document contains images or other embedded files the 
Save Embedded Files dialog box will appear, as shown below.  

Click on the Change Folder button, select the same location as you chose above for the 
file, click on OK, and then click on OK again. Both the file and the images are saved 
to the same location. 
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Your document and images are now ready to be uploaded to WebCT. There are three 
ways to upload the document and embedded images.  
You may upload the document and images one-at-a-time. 
You may use a compression utility to zip the folder that contains the files.  (Zipping the 

folder will allow you to upload the document and images all at once. Once the Zipped 
file is uploaded you will use WebCT’s unzip utility. Use it to unzip the zipped file 
back into the folder containing your web page and images). 

You can set up WebDAV on your computer and drag files from your computer to the 
specific course’s WebCT folder. 

Converting Excel Files to HTML 
Using the same method for Excel conversion as you would for Word is fine if the 
spreadsheet is small (under 100 kb). As above, click 'File' on the main menu bar, then 
Save as Web Page' 

 

 
You'll notice there is a 
'Publish' button in the 
following window, but 
you most likely will not 
need to go through this 
process in Excel. If the 
spreadsheet has multiple 
pages, you can convert it 
all at once, but this will 
create framesets for your 
spreadsheet, which can 
create enormous files. 
Selecting the radio 
button next to 'Entire 
Workbook' will create 
these framesets.  
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If your spreadsheet 
contains many pages but 
you do not want 
framesets, select the 
radio button next to 
'Selection Sheet', and 
save the pages one at a 
time. 

 

Other than these steps, 
all you need to remember 
is to exclude any spaces 
in your filename, and 
click “Save”. 

 
The following elements do NOT convert well:  
Footnotes  
Headers and footers 
Special characters  
Superscripts and subscripts  
Small caps  
Paragraph formatting such as double 
spacing and first-line indentation  

Anything involving tabs  
Page numbers  
Page breaks  
Styles, including headings  
Anything you draw with Word's drawing 
tools, such as WordArt  

 
The following elements DO convert well:  
Tables  
Tables of contents and indices  
Bulleted or numbered lists  

Images in GIF format  
Bold, italicized and underlined text  
Fonts, though the size may change  

For maximum control over how your pages look, use only the most universal fonts such 
as Times New Roman, Arial, and Courier. While fonts convert well to HTML, your 
chosen font will only be visible if visitors to your Web page have that font installed on 
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their own computer. Your user's computer will substitute another font for the one you 
used, changing the look of your page, if the font is not installed on their computer. 
 

Manage Files 
Manage Files stores all the files that make up your WebCT course. This storage area is 
located on the networked computer running the WebCT server software. Manage Files 
uses a file structure similar to those found in the Windows and Macintosh operating 
systems. This tool allows you to: 

Browse through the WebCT permanent files for files and images 
Upload files to the WebCT server from your computer  
Download files from the WebCT server to your computer  
Zip and unzip (compress and decompress) files on the WebCT server  
Copy, delete, rename, and move files, and create new folders 

 

 
 

Creating New Files In Manage Files. 
Using File Manager, you can create new text and HTML files in the folder of your 
choice. Folders are listed under Folder and Files in the bottom half of the Manage Files 
screen.  
63. Choose the destination folder by selecting the checkbox next to the folder's name. 

Note: you cannot create a new file in the WebCT-Files folder.  
Select Create File under Options: Files. 
Type a name for the new file in the small text box, making sure to leave the .html file 

extension. 
Note: the new name cannot contain any of the following characters: tabs, line feeds, 

carriage returns: ~ [ ] ! @ # $ % ^ & * ( ) + ` } } | \ < > , ? / ; ' "  Choose to type in a 
standard text box or to use the HTML editor. 

Create the content for your new file by typing in the large text box. For easier viewing, 
you can resize this text box by adjusting the width and height controls. Adjusting the 
size of the text box has no effect on the file's content.  

Click Save when you have finished entering file content.  
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Editing Files 
Occasionally, you may want to edit files in WebCT. The Edit option enables you to 
make changes to the text and codes in your .txt and .html files in Manage Files.  
64. Select the checkbox next to the file you want to edit. Files are listed under Folders 

and Files. (Note: you cannot edit files in the WebCT-Files folder.) 
Select Edit under Options: Files.  
Change the content of the file you may use either the standard text editor or the HTML 

editor. For easier viewing, you can resize this text box by adjusting the width and 
height controls. Adjusting the size of the text box has no effect on the file's content.  

Click Update when you have finished entering file content.  

Copying Files 
The Copy option allows one or more files to be copied from the current folder to another. 
Copies of the file will thus exist in two folders.  
65. Select the checkbox (es) next to the file(s) you want to copy.  
Select Copy under Options: Files. 
Click Go. The Copy Files screen appears.  
The file(s) that you selected to copy appear on the left side of the screen. If you decide 

not to copy a file, clear its checkbox. Select a destination folder from the list box on 
the right and click Copy. .  

Moving Files 
The Move option allows one or more files to be moved from the current folder to another 
folder. When a file is moved, it will no longer exist in the original folder. If you want to 
leave a copy of the file in its original folder, use the Copy feature instead. 
66. In manage files, select the checkbox (es) next to the file(s) you want to move. 
Click Move under Options: Files. 
The Move Files screen appears.  
The file(s) that you selected appear on the left side of the screen. If you decide not to 

move a file, clear its checkbox. Select a destination folder from the list box on the 
right and click Move.  

Renaming a File 
The Rename option allows you to rename a file in Manage Files.  
67. Select the checkbox next to the file you want to rename. Note: you cannot rename 

files in the WebCT-Files folder.  
Select Rename under Options: Files.  
The Rename File screen appears.  
Type a name for the new file in the small text box. Note: the new name cannot contain 

any of the following characters: tabs, line feeds, carriage returns: ~ [ ] ! @ # $ % ^ & 
* ( ) + ` } } | \ < > , ? / ; ' "  

Click Rename.  

Deleting a File 
The Delete option allows you to delete one or more files from Manage Files.  
68. Select the checkbox (es) next to the file(s) you want to delete.  
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Select Delete under Options: Files.  
The Delete Files screen appears.  
The file(s) that you selected appear on the left side of the screen. If you decide not to 

delete a file, clear its checkbox. Click Delete.  

Displaying File Attributes  
Size, date, and time attributes are displayed by default in the Folders and Files listing. 
You can hide an attribute by clearing its checkbox. To refresh the screen, click Update.  

Uploading and Downloading Files in WebCT 

Uploading Files using Manage Files 
Uploading a file involves transferring it from your personal computer to the remote 
server hosting your WebCT course. Note: if you want to upload multiple files, zip them 
up with a file compression program and then upload the .zip file or use WebDAV. 
69. Choose a destination folder by selecting the checkbox next to the folder's name. Note: 

You cannot upload files to the WebCT-Files folder.  
Select Upload under Options: Files.  
Click Browse to locate the file to upload. Note: the file name cannot contain any of the 

following characters: tabs, line feeds, carriage returns: ~ [ ] ! @ # $ % ^ & * ( ) + ` } 
} | \ < > , ? / ; ' "  

Select the file and Click Open. 
Click Upload.  

Downloading Files using Manage Files 
Downloading a file involves transferring the file from the remote server hosting your 
WebCT course to your personal, local computer. Note: if you want to download multiple 
files at once, zip them first and then download the .zip file. 
70. Select the checkbox next to the file you want to download.  
Select Download File under Options: Files.  
The Download file confirmation window appears.  
Click Download.  
Follow screen directions for saving the file on your computer. 

Uploading More than One File at Once 
Many web pages that you wish to place in your course have links to other web pages, 
images, sounds, etc. If you forget to upload the linked files or if you upload the linked 
files to the wrong folder (directory) the links will not work, the images will not show, the 
sounds will not play, or the web presentations will not display. Since WebCT’s file 
manager only allows you to upload one file at a time uploading a web based presentation 
or a mini web site could take some time to accomplish.  
 
To make this easier for you WebCT has provided us with two tools 
71. The zip and unzip tools inside of Manage Files (We will count this as one tool) 
72. The WebDAV tool.  
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WebCT’s unzip tool will decompress (upzip) a zipped file that contains multiple files that 
you have zipped (compressed) into the compressed file using a zip utility like WinZip. 
The WebDAV tool allows you to set up a folder (actually a Web Folder) on your 
computer in which you just drag files into just like any other folder you have worked 
with.  
 
In order to Zip and Unzip files on your computer you will need to install an additional 
Zip utility (program) on your computer. This will allow you to Zip a folder of files on 
your computer, upload the zipped file into WebCT and then use WebCT’s unzip tool to 
unzip the file back into the folder. You can also run this process in reverse. You can zip a 
folder of files in WebCT, download the zipped file, and unzip the file on your computer.  

Zipping and Unzipping Files using the WinZip Utility 

Zipping a folder using right click 
To compress an existing folder to a WinZip file right click on the folder’s icon.  A pop-up 
menu will appear and one of the options will be “add to (folder’s name).zip. Clicking this 
option will create a compressed file out of the folder and place it on the desktop.   

Unzipping a Folder Using right click  
To decompress a folder simply right click on it’s icon and select, “extract to 
…folderpath” the file window will appear which gives the options for where the folder 
will be stored. If right click is not available on the computer being used refer to the 
“Unzipping a Folder without a right click,” directions. 

Zipping or Unzipping a Folder without a right click 
When the right click on the computer is disabled look under the file menu to find the 
commands that are normally displayed in the pop-up menu that displays using the right 
click. 
 

Windows Zip Utilities 
WinZip: http://www.winzip.com/ 
UltimateZip: http://www.ultimatezip.com  
this program is similar to WinZip and it is free. 
 

Macintosh Zip Utilities 
ZipIt 
StuffIt Deluxe 
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Zipping and Unzipping Files using the WebCT Zip Utility 

Zipping Files  
The Zip feature compresses several files into one file. This feature is particularly useful if 
you want to download more than one file at a time.  
1. Select the checkboxes next to the files you want to zip.  
2. Select Zip in the Actions Panel.  
3. The Zip Files screen appears.  
4. The files that you selected appear on the left side of the screen. If you decide not to 

zip a file, clear its checkbox. Select a destination folder from the list box on the right, 
and type a name for the new file in the File Name text box. Note: the new name 
cannot contain any of the following characters:  tabs, line feeds, carriage returns : ~ [ 
] ! @ # $ % ^ & * ( ) + ` } } | \ < > , ? / ; ' "  

5. Click Zip.  
6. Once you download the zip file to your local computer, you can unzip the file with 

WinZip (PC), ZipIt (Mac), or another file compression application.  
 

Unzipping Files 
This operation allows you to unzip the contents of a zipped (compressed) file. A zipped 
file can be identified by the .zip extension.  
73. Select the checkbox next to the file you want to unzip.  
74. Select Unzip in the Actions Panel.  
75. The Unzip File screen appears.  
Select a destination folder for the unzipped files from the list box and click Unzip 
 
 
 

Combine all of the files on a course CD into one zipped, archived 
(compressed file).  
76. Open WinZip and click the “New” button. 
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77. Choose the location to save the New Archive (compressed file) and click the OK 
button. 

 

The Subfolder name should appear in the 
Save In drop down menu.  

78. Choose the CD drive that contains your course CD from the Look in: drop down 
menu. 

 
79. Highlight all of the files and folders that appear in the CD window. Tip: Click on 

the first file, hold your shift key down, and click on the last file. This will highlight all 
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of the file and folders automatically. Click the Add button.  

 
80. When the archiving (compression) process completes all of the files will appear in the 

WinZip window. Click the close box, the X in the upper right hand corner of the 
WinZip window to close WinZip.  

 
81. Verify the location of your newly create Zipped file (compressed archive).   
 

Accessing Manage Files using the WebCT Browser 
As you design your WebCT course, you will occasionally encounter a Browse button. 
Clicking this button will open the WebCT Browser screen. Like the File Manager, the 
WebCT Browser lets you upload files and select files from your WebCT folders for use 
in WebCT tools such as Calendar, Quiz, and Course Content. 
82. To view the contents of a folder, click the folder.  
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To preview a file, click on the magnifying glass near the filename.  
To choose a file, select its option box and click Add Selected. You can only select one 

file at a time.  
To choose a file from your personal computer, click the Browse button.   

Uploading a file with the WebCT Browser  
While viewing the contents of the manage file area 
83. Click Browse. To locate and select the file on your computer 
Click Open 
Select a destination for the file in the Upload to drop-down list.  
Next to Upload to, click Upload. The WebCT Browser screen reappears.  
Locate the file, verify the option button next to the file is selected, and then click Add 

Selected. 

WebDAV Info 
WebDAV Info displays the URLs needed to create web folders that can be used to add 
and delete content to and from your course.  

Managing Files with WebDAV 
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You can view, manage, move, copy, save, and rename the files and folders on your 
WebCT server just as you would perform the same actions on your computer. However, 
when you view the WebCT course contents in your Web folder, you see a list of files and 
folders and their associated Internet addresses or URLs. To set up WebDAV, map a web 
folder to your WebCT server using the file system for your operating system. You can set 
WebDAV to access both the Manage Files folder and the Course Backup folder 

Setting up WebDAV on Windows 2000 or Windows XP 
Note: When using WebDAV with Windows XP, you may have to enter your WebCT 
username and password multiple times. 
From your myWebCT, click WebDAV info. The WebDAV Info screen appears.  
From the WebDAV info screen, select the URL of the folder for the course you want local 

access to: Course files or Course backups.  
Copy the URL including http://  
From your Windows desktop, double-click My Network Places. The My Network Places 

folder opens. Note: See Microsoft Windows online help for information about using 
My Network Places.  

From your My Network Places folder, double-click Add Network Place. The Welcome 
to the Add Network Place Wizard appears.  

In the Type the location of the Network Place text box, paste the URL you copied.  
Click Next. The Enter Network Password screen appears.  
Enter your WebCT designer User nameand PasswordImportant: If you are sharing a 

local computer you should clear Save this password in your password list.  
Click OK. The Completing the Add Network Place Wizard screen appears. Note: If your 

password is not valid see your WebCT administrator.  
In the Enter a name for this Network Place text box, enter a name.  
To complete your WebDAV setup, click Finish. A Microsoft Web Folder appears 

containing your WebCT course files. You can view, manage, move, copy, save, and 
rename files and folders on your WebCT server just as you perform the same actions 
in the file manager.  

Setting up WebDAV on Windows 98 
From your myWebCT, click WebDAV info. The WebDAV Info page appears.  
From your WebDAV info page, select the URL for the course and folder you want local 

access to: Course Files or Course Backups and copy the URL including http://  
Double-click My Computer and then open Web Folders.  
Double-click Add a Web Folder.  
For location, paste your WebCT folder URL.  
When prompted for a User Name and Password, enter your WebCT Designer User Name 

and Password. Important: If you are sharing a computer you should clear Save this 
passwordin your password list.  

In the Network Place text box, enter a name.  
To complete your WebDAV setup, click Finish. A Microsoft Web Folder appears 

containing your WebCT course files. You can view, manage, move, copy, save, and 
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rename files and folders on your WebCT server just as you perform the same actions 
in file manager. Note: See Microsoft Windows online help for more information on 
using Microsoft Web Folders.  

Setting Up WebDAV on Mac OS X Using Finder 
Important: If your WebCT server is using SSL, you cannot set up WebDAV on Mac OS 
X using Finder. See Setting up WebDAV on Mac OS 9 and Mac OS X using a WebDAV 
application. 
WebDAV is integrated into Mac OS X allowing you to mount your course's Manage 
Files or Course Backups and use the Finder's file management system to move and edit 
files. Note: To use OS X native WebDAV, you may need to upgrade to OS X 10.2 .  
From your myWebCT, click WebDAV info. The WebDAV Info page appears.  
From your WebDAV info page, select the URL for the course and folder you want local 

access to: Course Files or Course Backups.  
Copy the URL including http://  
From the Finder click Apple+K on the keyboard or use the menu item Go > Connect to 

Server.  
The Connect to Server window appears. In the Address: text box, paste the URL that you 

copied. Click Connect.  
When prompted, enter your WebCT Designer User Name and Password. Your directory 

is mounted. You can view, manage, move, copy, save, and rename the files and 
folders on your WebCT server just as you perform the same actions in the file 
manager. Depending on your Finder preferences, an icon may display on your 
desktop or the files may be accessible through the Finder.  

Setting up WebDAV on Mac OS 9 and Mac OS X Using a WebDAV 
Application 
For more information, see the WebCT Knowledge Base: 
http://help.webct.com/dev_knowledgebase 
 

Creating a Content Module   
Content Modules provide a way of grouping relevant course content together. In 
general, WebCT course content consists of content pages that can include lecture notes, 
multimedia presentations, assignments, and quizzes. You can organize content pages into 
a Table of Contents, which provides students with a guide to the sequence of study. The 
hierarchical structure also makes it easier for students to find specific course content. 
You create the Table of Contents by adding headings and subheadings. You can then add 
content within this hierarchy by adding files of content. These files appear as hyperlinks 
in the Table of Contents, which provides students with easy access. When a student clicks 
on a hyperlink, WebCT displays the content pages that you have created.  
Your course files can include; Text files. HTML files, and Multimedia files  
Notes: 

You must upload any files that you intend to use in your course to WebCT. See Manage Files 
or WebDAV for more information.  

You must update the Student View before modified course content becomes available to 
students.  
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Working with Headings in a Content Module 

Adding a Heading 
Use Add heading to create a new heading or subheading in your course table of contents. 

You specify where you want the heading to be added.  
Under Table of Contents, select the heading after which you want the new heading 

appear.  
Under Options: Table of Contents, select Add heading. The Add heading screen 

appears.  
In the Title text box, type the new heading, and click Add. The revised table of contents 

appears. Note: you can now add content under your heading with Add file or Create 
and add HTML File. 

Deleting a Heading in a Content Module 
Use Delete to delete a heading or subheading from your course table of contents.  
84. Under Table of Contents, select the heading, which you want to delete.  
Under Options: Table of Contents, select Delete  A warning message appears.  
Click OK. The revised table of contents appears.  

Adding a File to a Content Module 
Use Add file to add course content to a heading or subheading in the table of contents. 
You specify where you want the file to be added. 
85. Under Add or Delete Items, select Add File and click Go. The Add File screen 

displays the files that are available in your course.  
From the list of files in your WebCT course folder (in the File Manager), select the file 

that you want to add to your course, and click Add. The revised course table of 
contents appears.  

To upload multiple files, hold down the control key while selecting the file names. 

Creating and Adding an HTML File in a Content Module 
Course content HTML files can be created outside of WebCT and uploaded with 
Manage Files. WebCT also provides you with the ability to create HTML files while you 
are building your course content by using Create and Edit HTML File. You add an 
HTML file to your course folder, and then edit it with HTML:HTML Editor. 
86. Under Options: Table of Contents, select Create and Edit HTML File.  The 

Create and Edit HTML File screen appears.  
In the Filename text box, type the name of the new file. (Note:  Be sure to leave the 

.html suffix in the file name.)  
In the File content box, type the title that will appear as the heading name in the course 

table of contents.  Type this title in the box where you see <title>Put your title 
here</title>.  Replace “Put your title here” with your own title. 

 
Replacing Existing Files in the Content Module 
 
You can replace files in your course Table of Contents. 
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87. Under Table of Contents, select the checkbox next to the file you want to replace. 
Click on Add Files.  The Add Files screen appears. 
Under Filenames highlight the file you want to replace the existing file. 
Click on the checkbox, Replace the file selected in the Table of Contents, and then 

click on Add.  The file is now replaced with the new file. 

Deleting Content from Your Course 
You can delete headings from your course Table of Contents.  
88. Under Table of Contents, select the heading that you want to delete.  
Under Add or Delete Items, select Delete, and click Go. A warning message appears.  
Click OK. The updated Table of Contents screen appears.  

Changing where the student sees the action menu 
89. To change the location of the action menu, under Optons: Content Module, select 

Edit Content Module Settings. The Content Module Settings screen appears.  
Under Action menu, Location, select the location for the action menu, and click Update 
The Table of Contents screen appears. Note: you can choose to display the action menu 

at the top of the page (default), at the left of the page, or hide it. If you choose to 
place the action menu at the left of the page, you can specify the width of the menu, 
in pixels. 

Changing where the student sees the table of contents 
90. To change the location of the table of contents, under Optons: Content Module, 

select Content Module Settings. The Content Module Settings screen appears.  
Under Table of contents, Location, select the location for the table of contents, and click 

Update. The Table of Contents screen appears. Note: you can choose to display the 
action menu at the left of the page, or hide it. If you choose to place the table of 
contents at the left of the page, you can specify the width of it, in pixels.  

Changing what is seen first 
91. To change what the student sees first in Content Module, under Options: Content 

Module, select Content Module Settings. The Content Module Settings screen 
appears.  

Under Table of Contents, A reader entering this content module will first see, select 
what the student will see first when entering the content module, and click Update. 
The Table of Contents screen appears. Note: you can choose whether the student 
sees the table of contents (default), or the first heading in the table of contents. 

Changing how headings are numbered  
92. To change heading numbers, under Options: Content Module, select Content 

Module Settings. The Content Module Settings screen appears.  
Under Table of Contents, Page numbering, select how you want the items in the table 

of contents numbered, and click Update. The updated Table of Contents screen 
appears. Note: you can choose whether to display heading numbers beginning from 
the specified initial number (default), or hide heading numbers. 
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Changing what appears in the Action Menu 
93. To change the items that appear in the Action Menu, under Options: Content 

Module, select Content Module Settings. The Content Module Settings screen 
appears.  

Under Action Menu, Select the Action Menu items you would like to appear in this 
module, select the check boxes of the items that you want to appear on the Action 
Menu. To remove an item from the Action Menu, clear the check boxes of the items 
that you want to remove.  

Click Update. The Table of Contents screen appears. 

Changing the titles of headings 
94. To change heading titles, select Edit titles.  The Edit Content Page Titles screen 

appears.  
Type the changes to your heading titles into the text boxes, and click Update. The 

updated Table of Contents screen appears. 
 
Updating Student View 
Use Update Student View to make changes to content pages available to your students. 
You must update the student view when you: 

• Upload a newer version of a file.  
• Modify the text of a file.  
• Modify colors, counters, or background images of content pages.  
• Modify the Action Menu on a content page.  

To update the student view: 
95. The Update Student View button appears when you are in Designer view and you 

select one of the following:  
• Table of Contents screen.  You get here by selecting Content Module from the 

Course Menu or the Homepage.  You will find Update Student View under 
Options: Content Module. 

• Content Module Settings screen.  You get here by selecting Edit Content 
Module Settings from the Table of Contents page.  You will find Update 
Student View under Update Listing on the right side of this screen.  
• Content Page Settings screen.  You get here by selecting a content page from 

the Table of Contents page.  The Content Page Settings screen appears.   
Update Student View appears at the top of this page. 

• From the Control Panel, click on Update Student View in the second 
column under the Edit Page or Tool Section.  

96. Select the type of update that you want.  
a. Update entire course: all content pages and Action Menus are updated. Note: 

This operation may take several minutes to complete, depending upon the 
number of content pages that have to be updated.  

b. Update changes to text, colors, and Action Menu: all Action Menus are 
updated, along with any content pages that have changed.  

97. Click Update. The Update Student View Report screen appears.  
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98. To return to Content Module or the content page, click the hyperlink to the module.  
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